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Thanks you for purchasing DUO pen.

DUO is an innovative pen mouse that  easily makes your computer become tablet PC.

You can write, draw, sketch, sign and etc. on screen without keyboard and mouse.  

For more information, please visit http://www.DUOPenMouse.com.

Copyright @ PenAndFree Co., Ltd.
Partents, Brand, Copyright and intellectual properties 
related this manual belong to PenAndFree Co., Ltd.
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1. Notice for safety 2. Variety of functions supported by DUO

Be aware of impact
When pen is imapacted or dropped, it is possible to be damaged or deformed.

We recommend not to convert or disassemble units.
Do not disassemble the products. If you need to be supported, contact your local service center or
www.penandfree.com.

The above reasons are not  in warranty repair or replacement service.

Please keep the product clean.
It is possible to disorder for USB connector having dirt.
Clear out the dirt with soft cloth, do not use chemical cleaner such as thiner or volatile solvent.

Please use the pen for proper uses only.
Be aware of children about devices to play, bite, swallow, throw, and etc.
Pen tip is possible to be swallowed into neck.

Avoid from fire or hot stuff.
If product is near or in fire or hot stuff, it can be damaged or deformed.

Keep product away from water or liquid.
Product is not waterproof. Please keep it away from liquid or water.

Be careful of pen sensor strong force in pen-tip replacement.
When pen sensor is grapped with strong force in pen-tip replacement, the sensor is possible to be damaged. 
Do not touch the pen sensor.

(2) Various pen softwares 

(1) Key functions 

Adobe Photoshop
Adobe illustrator
PDF Annotator

DUO Annotator
DUO Board
DUO InkNote

Nate on messenger
Graphic or handwriting
softwares

Office annotator  
MSN Messenger 
Sticky notes 
Ink Desktop
MS-OneNote
MS-Paint 

DUO is the most compatible pen device which allows tablet functions on non-tablet laptop. 

Fine writing
Air touch function applicable on virtual space
Note-taking function using ball-pen tip and paper 
Gesture and charactor recognition function
Superior writing quality using virtual pressure 
Complete support from MS Ink Library
Support Plug and Play
Mouse and Virtual keyboard function

1)  MS Software 2)  Adobe Software 3)  PnF Software 4)  etc. 
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3. Product composition 4. Using DUO

① First, install hardware and driver software following
     provided installation guide. 

② Place DUO receiver station on laptop screen and
    connect USB connector to PC.

④ After PC recognizes DUO hardware, execute pen 
     calibration.

③ Install driver software (PENonPC) and confirm if laptop
     recognizes hardware. If laptop recognizes hardware
     properly, monitor-shaped PENonPC icon will be 
     activated located on lower right corner of system tray.   

If placing on top of laptop is not suitable because of
knob, connect DUO on either right or left side of 
laptop. If DUO is placed on either right or left side of 
laptop, you have to set up station attachment position
accordingly from option menu of drive software (PENonPC).

Caution

If laptop does not recognize hardware

Pen tip Mouse right click

Power LED

Deco fixture

Receiver sensor

Mouse left click
Battery cap

Pen

Station USB

Connected

Disconnected
Guide

Connect USB connector to different port.

When using USB HUB, connect DUO in PC USB
port directly. 

Quit PENonPC program and restart.
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6. How to calibrate pen

When pen calibration is not correct, it has to be set
up properly for appropriate usage. Click on monitor
shaped PENonPC icon located on lower right corner 
of system tray. Menu will be appeared. 

Select “Adjust working area” on appeared menu.

(1) Central area calibration 

(3) Writing speed

(4) Station position

Rapidly : Pen writing is fast, but writing quality is not
               so good.

Softly : Pen writing is slow, but writing quality is very
            real.

Click station position of monitor screen.
(Station must be placed selected position.)
Default is upper location.

Operating is the same in any position.

Adjust pen writing speed.

5. O
ption setting

5. Option setting

Control the lever left or right side to adjust brush pen
touch.

Option menu is to set pen type and pen effect
in Microsoft Ink writing.

Control the lever left or right side to adjust level of pen
touch pressure.

If lever slides to left, the pressure of the pen is soft.
If lever slides to right, the pressure of the pen is strong.

(1) Pressure level of pen 

Going left is to decrease brush effect.
Right heading is to increase brush effect.

(2) Brush 
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7. How to use DUO pen 

(1) Start with Pen
Grap pen like pencil or ball-point pen.
Pen is designed to operate when user grap the pen in 
any direction.
Signal from pen should be approached well to sensors 
in station.
Remove obstacle between station and pen to avoid error.

1) Click (Select)

Click !

Click !
Click !

Click the pen tip once on the 
suface lightly.

2) Double click(Execute)
Click the pen tip twice on the 
suface lightly.

3) Drag
After clicking what user want to 
point, move the pen tip to where 
user want to bring the final 
destination of the pen tip without 
releasing pen clicking.

Caution

Depending on direction or angle of pen, mouse cursor and pen tip may not be aligned perfectly. It is not due to 
product malfunction, you must keep the same hand position as you did when you operated pen calibration. 

(2) Additional pen calibration

Tip

This is a process to align pen calibration on right, 
left,upper and lower sections of screen. 

Press on line appeared on screen with pen tip.

Wait until mouse cursor is aligned with line.

When mouse cursor and line are aligned, next step
will automatically occur.

Caution

You must keep the same pen position during pen 
calibration as you use pen in usual circumstances. 

Record measurement of screen size on backside of 
laptop for later use.  

Notice

After central area calibration, you can go to next step
automatically.

Pen calibration aligns pen pointer and mouse cursor.

PENonPC automatically recognizes screen size and
notice cross-shaped mark.

Hold pen comfortably and place it on center of cross
mark. After a second, pen calibration will be finished 
automatically.

Occasionally, it is not imported screen size from 
monitor automatically in some PC. Pop-up window
asking for monitor size will appear on your computer 
screen. As shown in next picture, measure width 
and length (in mm) using ruler and click OK.
If measurement is not possible, select the closest
inch size. 

6. H
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(3) Using with ballpoint pen

DUO pen can be used as ballpoint pen with changeable ballpoint tip.
Please refer to "How to change pen tip" section for for detailed instructions.
Put station on the surface as shown below..
Clip A4 paper into station clipper.

We recommend clipping paper horizontally in accordance with screen. 
For XP and VISTA Home basic users, use DUO Ink note. For VISTA Home premium and higher OS users, 
use Windows Journal Note.
Please maximize your program screen to fully cover your computer screen. 
For detailed intructions, please refer to DUO inkNote and Windows Journal examples of user guide.

7. H
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DUO InkNote WIndows Journal Note

(2) Replace pen-tip

Caution

Insert

Pull out

Turn the cage of pen head to counter clockwise, remove the cage, and  pull pentip out.
Insert new pentip. Use the pencase tool to change the pen tip.

After replacement, turn the cage to clockwise to cover pen head.

When the cage is aparted from pen head and while sensor film can be damaged, it is caused out of order. 

Be aware of sensor damage.

If pentip is stuck in the middle, do not insert with force. Pull out pen tip and then try again.

When pen does not click within 30 seconds after last click, pen will be automatically 
initiated sleep mode. 

When double-click is inconvenient, set up double click speed more slowly by selecting 
“Control panel>Mouse>Double-click speed” 

Push
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NOTE주의
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Move your pen to check usage space. 
Pen usage space should be the same as laptop screen.

On DUO Inknote, click on ‘Ink mode’. On Windows 
Journal, choose pen function in order to write.

Write directly on papers using DUO with ballpoint pen tip.
Written context on papers will appear on screen 
simultaneously.

To stay inside usage space, please watch the screen 
as you write on papers.

After finishing note taking on papers, you can save your
work directly on your computer. 

You can attach saved noted on MS-Outlook.

8. XP, VISTA Home Basic OS 

(1) How to install DUO Annotator 

To use annotate functions on MS-Office, XP and 
VISTA Home Basic OS user must install DUO Annotator. 

Below items will be installed with DUO Annotator.
  - Microsoft .NET Framework
  - Tablet PC Platform SDK
  - DUO InkNote
  - DUO Annotator

Please do not install when MS-Office 2003 or 2007 
is not already installed.

8. XP, VISTA Hom
e Basic O

S

  <Microsoft.NET Framework>
- Proceed by clicking on [Next].
- Select [I accept ..] and click on [Next] button.
- Click on [Finish] to complete the installation.

   < Tablet PC Platform SDK >
- Proceed by clicking on [Next].
- Select [ I accept ..] and click on [Next] button.
- Select [ Anyone who..] and click on [Next] button.
- Select [ Complete ] and click on [Install] button
- Click on [Finish] to complete the installation.

  < DUO InkNote >
- Proceed by clicking on [Next].
- Click on [Install] button.
- DUO InkNote will be installed.

< DUO Annotato >
- Select language and click [OK].
- Click on [Next] button.
- Select [I accept ..] and click on [Next] button.
- Select [Any one ..] and click on [Next] button.
- Click on [Install] button.
- Click on [Finish] to complete the installation.

DUO Annotator is installing. Please wait for a 
moment and press [OK] to finish.

To use character recognition function, you must 
install  character recognition package from 
Microsoft homepage.

For more detail information, refer to“Installing 
and using character recongnizer”section
in this Guide book.

LCD size

NOTE
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1) Using on MS-Word 2003

⑤ After finishing writing, click on `Insert and Quit`. 
    Your handwritten notes will be added on MS-Word.

① Connect DUO to PC USB port and start MS Word.

② Move cursor to desired place where you want to add 
     in your annotation.

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar. 

④ By choosing various icons, you can select various functions.  
⑥ Your handwriting can be recognized as text and added
     into documents. Click on Charactor Recognition button 
     and window will appear as shown below.

⑦ Write desired contents.

⑧ Click on Recognize button on lower right corner. 

⑨ Click on `Insert` button. Your handwriting will be added 
     into documents as text. 

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

(2) Using DUO pen on MS Word

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ
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2) Using on MS-Word 2007

1) Using on MS-Excel 2003

(3)Using DUO pen on MS-Excel
① Connect DUO to PC USB port and start MS-Word.

②  Move cursor to desired place where you want to add 
      in your annotation.

④ As shown below, Ink toolbar will be active.

④ By choosing various icons, you can select various functions.

① Connect DUO to PC USB port and start MS-Excel.

② Move cursor to desired place where you want to add 
     in your annotation. 

⑤ After finishing writing, click on `Insert and Quit`. 
     Your handwritten notes will be added on MS-Word.

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar. 

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ

⑥ Basic functions are the same as on MS-Word 2003.

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S
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③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar.

⑤ By choosing various icons, you can select various 
     functions.

⑥ After finishing writing, click on `Insert and Quit`. 
     Your handwritten notes will be added on MS-Excel.

① Connect DUO to PC USB port and start MS-Excel. 

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar.

④ As shown below, Ink function toolbar will be active.② Move cursor to desired place where you want to add 
     in your annotation.

⑦ Basic functions are the same as on MS-Word.

④ As shown below, Ink function toolbar   will be active.

2) Using on MS-Excel 2007

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S
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⑤ By choosing various icons, you can select various functions..  

① Connect DUO to PC USB and start MS-PowerPoint 2003. 

② Start on new PowerPoint document or open saved file.

③  If you already installed DUO Annotator, DUO Annotator 
      toolbar will appear on screen after starting MS-Office
      programs. Let`s try annotation function using DUO pen.
      Click on DUO Annotator icon on Toolbar.

④ As shown below, slide mode will automatically be active 
    and DUO Toolbar will appear.

⑥ After finishing writing, click on `Insert and Quit`. 
   Your handwritten notes will be added on MS-Excel.

⑦ Basic functions are the same as on MS-Word.
 

⑤ By choosing various icons, you can select various 
     functions. 

⑥ After finishing writing, click on `Insert and Quit`. 
     Your handwritten notes will be added on MS-PowerPoint. 

ⓐ Pen thickness

ⓑ Pen color

ⓒ Erase

ⓓ Options

ⓔ Insert and Quit

(4) Using DUO pen on MS-PowerPoint 

1) Using on MS-PowerPoint 2003

ⓑ ⓒ ⓓ ⓔⓐ

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ

8. XP, VISTA Hom
e Basic OS

8. XP, VISTA Hom
e Basic O

S
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⑦ When you close DUO Annotator pop-up window asking 
     whether to save written ink will appear. 
     Choose Keep in order to save your work.

⑧ You can write directly on slide mode using DUO pen.
     Start slide mode and move mouse cursor to lower left 
     corner. You can choose pen function from menu bar.

⑨ When you close slide mode, pop-up window asking 
     whether to save written ink will appear. 
     Choose Keep in order to save your work.

① Connect DUO to PC USB port and start MS-PowerPoint.

② Start on new PowerPoint document or open saved file.

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar.

④ As shown below, slide mode will automatically be active 
     and Ink toolbar will be appered.

⑤ By choosing various icons, you can select various 
     functions. 

2) Using on MS-PowerPoint 2007

ⓐ Pen thickness

ⓑ Pen color

ⓒ Erase

ⓓ Options

ⓔ Insert and Quit

ⓑ ⓒ ⓓ ⓔⓐ

8. VISTA Hom
e Prem

ium
 and higher O

S

8. XP, VISTA Hom
e Basic O

S
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⑥ After finishing writing, click on `Insert and Quit`. 
    Your handwritten notes will be added on MS-PowerPoint. 

⑧ Basic functions are the same as on MS-PowerPoint 2003

① Connect DUO to PC USB and start MS-Outlook 2003. 

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar.

⑤ After finishing writing, click on `Insert and Quit`. 

    Your handwritten notes will be added on . 
 

⑥ By using Charactor recognition fucntion, you can send 
     e-mail. Click on Charactor recognition icon and write on
     the window.  Click on Run button .
 

② Click on New E-mail button to create an e-mail.

(5) Using DUO pen on MS-Outlook

1) Using on MS-Outlook2003 

④ By choosing various icons, you can select various 
     functions. 

 (Note) Ink mail is applicable only on HTML mode.

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

⑦ When you close DUO Annotator pop-up window asking 
     whether to save written ink will appear. 
     Choose Keep in order to save your work.

8. XP, VISTA Hom
e Basic O

S

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ

8. XP, VISTA Hom
e Basic O

S
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⑦  Click on `Insert` button. Your handwriting will be added
      into documents as text.  

⑧ Basic functions are the same as on MS-Word.

① Connect DUO to PC USB and start MS-Outlook. 

②  Click on New E-mail button to create an e-mail

③ If you already installed DUO Annotator, DUO Annotator 
     toolbar will appear on screen after starting MS-Office
     programs. Let`s try annotation function using DUO pen.
     Click on DUO Annotator icon on Toolbar.

④ As shown below, Ink toolbar will be active. ⑤ After finishing writing, click on `Insert and Quit`. 
    Your handwritten notes will be added on . 
 

⑥ Basic functions are the same as on MS Word 2003. 
 

2) Using on MS-Outlook 2007

⑤ By choosing various icons, you can select various 
     functions. 

Note

Ink mail is applicable only on HTML mode. Please
change the mode.

 (Note) Ink mail is applicable only on HTML mode.

ⓐ Pen thickness

ⓑ Pen size indicator

ⓒ Pen color

ⓓ Pen style

ⓔ Clear all

ⓕ Erase

ⓖ Character recongnizer

ⓗ Options

ⓘ Insert and quit

8. XP, VISTA Hom
e Basic O

S

ⓑ ⓒ ⓓ ⓔ ⓕ ⓖ ⓗ ⓘⓐ

8. XP, VISTA Hom
e Basic O

S
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(6) MSN Messenger
This is Microsoft software which allows ink chatting using text and pen

③ When logged in successfully, main    
     window will be appeared as shown below. 

② Enter ID & password and login to messenger. If you
     don’t have ID, you have to register on MSN first.  
   

① Download and install the latest version of Windows live 
     messenger.( http://get.live.com/messenger)

④ Start conversation by right-clicking on another  person’s
     ID. (Right click on  person’s ID)

⑤ Below window will be appeared.

⑥ Start conversation.

⑧ Changing pen thickness and color is possible as well
     as eraser function. 

⑦ Now let’s try ink chatting. Click on ink chatting icon in
     order to carry out conversation using DUO pen. Click
     on “Send” button to send your writing. 

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S
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NOTE

⑨ Here are a few examples using extra 
     options on MSN messenger.

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S



In order to go back to windows screen, click on windows 
mode button. To go back to DUO board mode, click on 
DUO board mode button. 
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(8) DUO InkNote

1) How to use

2) How to give presentation using DUO Board

1) How to use

① Functions

DUO Ink note is a software which allows you to take,save 
and edit brief notes using DUO pen. Character recognition
is possible after intallating character recognizer. For more
information on character recognizer installation, please refer
to "Intalling and using character recongnizer"

Connect DUO to computer USB and start DUO InkNote by 
double clicking "DUO InkNote" on desktop.
The window will appear as shown next..

After connecting DUO to your computer USB, start DUO
Board by double clicking the icon on desktop screen.

Start desired software. In this example, we will use Internet
explorer.

Start Internet Explorer and go to desired website.
By clicking "new" button on DUO Board, change computer
screen to DUO board mode.

When screen captured, start writing on screen using pen 
or brush from menu on DUO Board.

In order to go back to windows screen, click on windows
mode button.

On windows mode, you can click icons and select 
desired menu.

To go back to board mode, click on DUO board mode 
button.

As described, you can easily convert computer screens
as a presentation board and explain easily using DUO 
pen.

Connect DUO USB to your computer. Start "DUO Board" 
already installed on your desktop. DUO must be connected 
to computer for proper operation.

(7) Using DUO board
DUO board is a handwriting software on image as user
define. This is only operated with PenAndFree’s product, 
and possible to write, edit and save captured image.

Open file

Ball point pen

Brush pen

Draw a line

Draw circle

Eraser

Highlighter

Clear all

Draw rectangle

Color and thickness
of the line .

Save 

Screen capture 

Switch button between
DUO board & Windows mode

Click to exit 
from DUO board

New page

Help menu button

② Screen capture function

In case of clicking this button, mode is 
changed to Windows mode automatically. 
The mouse cursor will be changed like a 
camera and users select what they want to
capture of the screen. After capturing part 
of screen, mode will be changed to DUO 
board mode to insert the captured contents.

③ Switch button between DUO board & Windows
    mode

change to 
Window mode

change to 
DUO board mode

Clicking Mode change button, user 
can switch mode from DUO board 
to Windows mode and vice versa.

In DUO board mode, you can not 
use any windows icon. In Windows 
mode, you can not use DUO board 
menus.

8. XP, VISTA Hom
e Basic O

S

8. XP, VISTA Hom
e Basic O

S
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2) Functions of Ink note

Start DUO Ink note.

Click on Ink writing mode        and choose desired pen size 
and color.

Write or draw on Ink note.

Click on Ink editing mode         Cursor will change to cross point.

Choose desired portion for cropping. 

Click on copy button     .

Start MS Word and click on place where you wish to
insert your handwirtten notes.

Use CTRL-V or select Paste menu from Edit menu.

Your handwritten notes will be inserted into MS Word file.

You can adjust size and location as desired. 

Pen thickness

Pen thickness(detail)

Pen color

Pen style 

Clear all

Erase

Charactor recognizer

Options

Background of page

Quit

Screen transparency

New document

Open

Save

Print

Cut

Copy

Paste

Ink writing mode

Ink editing mode

3) How to insert your handwritten notes on Word 
    file using DUO Ink note 

(9) Installing and using character
      recongnizer
To use character recognition function, you must install
DUO annotator provided from CD. Also, you should down
load character recognition package from Microsoft home-
page and intall on your PC.

Notice

Download is possible when your Windows is authentic.
Not supported in VISTA Home basic.

- Windows XP Professional Edition
- Windows XP Professional Service Pack 2
- Windows Server 2003
- Windows XP Tablet PC Edition 2005

1) How to intall character recognizer

Internet network must be connected.

You must install Tablet PC platform SDK prior to 
installing character recognizer.

You can only install on authentic Windows OS.

This can only be operated on OS listed below.

Notice

8. XP, VISTA Hom
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① Start Internet browser and go to download.microsoft.com.

② Type in `recognizer pack` on Search and click on 'go'.

③ Select Windows XP Tablet PC Edition 2005 Recognizer
     Pack from search result.

④ Continue clicking on button in order to verify authencity
     of your OS. When message appears requiring authencity
     verification related software, please intall the software.

⑤ After finishing verification, download screen will appear 
     as below. Click on "Download". 

⑥ When file download screen pops up, click on "Run".

⑦ After the download, safety warning screen will appear
    as shown below. 
    Click on "Run" (This step may be skipped on some PC)
 

⑧ When downloaded file is running, below screen will
     appear. Click on "Next".

⑨ When License Agreement screen appears, select 
     "I Agree .. " and click on "Next"

8. XP, VISTA Hom
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⑫ When installation setup is ready, click on "Install". ⑬ Click on "Finish" to complete the installation.

Character recognition function on XP can be done by 
using DUO InkNote.

① Click on DUO InkNote on desktop and start character 
    recognizer.

② Character recognizer will be started.  

③ Write on character recognizer and wait fot a second.

④ Recognized characters will appear on screen. By saving
    result in files, you can use them in different softwares 
    as well.

⑩ Type in User name and Organization name and click 
     on "Next"

⑪ On setup screen, select "Complete" and click on "Next".

2) How to use character recognizer
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⑤ Recognized characters will appear. If you want to insert 
     characters on MS Word, click on desired location and 
     click on "Insert" button.

This function can be used in MS-Excel, Outlook.

3) How to use character recognizer on MS-Office. 

① Start MS Word. 
    

② Start DUO Annotator on MS Word. DUO Annotator icon 
     is within Word Toolbar. 

③ Click on character recognizer on DUO Annotator.

④ Write desired characters and click on  Run button.

(10) Using PDF annotator
PDF annotator provides unrestricted annotations on PDF
file. It is not supported from OS by default. It is should be
purchased or download trial version from software website. 

① Go to http://www.grahl-software.com

② Download trial version from website or purchase 
     original version.

③ Application examples

PDF Annotator enables free annotation or writing on 
PDF files. You can emphasize by using highlighters or
attaching additional explanation on document. DUO
pen provides easier usage for annotating on PDF
document.  

④ Menu functions

Pen/Highlighters/Eraser
Size of font

Choose color of pen
Stamp function

Zoom in and zoom out
Move along page

8. XP, VISTA Hom
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(1) Using DUO pen on MS-Word

1) Using on MS-Word  2003

When using icon

When using menu bar

On MS Office, writing / drawing as well as keyboard typing words recognition is available. 

Choose desired ink type

Choose desired color

Choose ink thickness

If you want to disable ink annotation, click on
Stop Inking or press ESC button. 

Choose desired ink type

① Connect DUO to PC USB port and start MS-Word. 

② ③ Open saved document or preper new one.

③ When DUO is connected to PC, ink annotation function
     on MS-Office programs is automatically activated. Let’s
     try ink annotation function using digital pen. Click on 
     icon shown below or select ink annotation by View > 
     Tools > Ink annotation from menu bar. 

④ Ink annotation is activated as shown below. Ink 
     annotation function includes different Ink types, 
     eraser, colors and thickness. 

9. VISTA Hom
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① Connect DUO USB to PC and start MS-Excel. 

2) Using DUO pen on MS Word 2007

1) Using DUO pen on MS-Excel 2003

(2) Using DUO pen on MS-Excel

② Open a saved document or create a new excel file. 

③ Let’s try ink annotation using DUO pen. Click on icon 
     shown below or select View> Tools> Ink annotation 
     from menu bar.  

④ Ink annotation will be activated as following. Ink 
     annotation function includes different types of pen, 
     eraser, colors and ink thickness. 

Choosing types of pen

Choosing eraser function

Choosing colors

① Connect DUO to PC USB port and start MS-Word. 

③ New menu with same icons as MS-Word  2003  will
     be appeared, and then, instruction and functions are
     the same as Office Word 2003. 

② Click Review on menu bar and select Start ink tool
     located far right end. 
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① Connect DUO to PC USB port and start MS-Excel. 

2) Using DUO pen on MS-Excel 2007

② Click View on menu bar and select ‘Start ink tool’ 
     on far right end. 

③ New menu with same icons as Office Excel 2003
     will appeare. Instruction and functions are the same. 

Start your work after choosing desired thickness 
and colors. 

Various colors are available as shown below. . 

Choosing pen thickness.

(3) Using DUO pen on PowerPoint. 

① Connect DUO to PC USB and start MS-PowerPoint. 

② Open saved document or prepare a new one. 

1) Using DUO pen on MS-PowerPoint 2003
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③ When using DUO, ink annotation function on MS
     Office programs will automatically be activated.
     Click on icon shown below or select View > Tools 
     > Ink annotation from menu bar. 

④  Ink annotation function is available all the same MS
     Office 2003 or above.

When using icon

Choosing ink types

Choosing eraser function

Using color

Various colors are available for use.

Using menu bar

⑤ Start writing as shown below.

Ink thickness
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⑥ Ink annotation is also available for presentation slide
     show. Press slideshow key (F5) in order to activate
     slideshow mode. 

⑧ Pen menu execute the same way as ink annotation. 

⑨ Below icons are the same as right button menu of
     mouse in conventional slideshow set up. 

⑩ Arrows move slides back and forth. ⑫  Below pop-up will appeare when slideshow is
      finished. 

⑪  Deliver your presentation more effectively using ink
      annotation. ⑦ Ink annotation is activated by moving mouse to

     lower left corner. 

This message asks whether to save inserted ink
annotation on presentation slides or not. If click
on “Keep”, written ink annotation will be saved
along with original document. If click on “Discard”, 
only original document will be saved.
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① Connect DUO to PC USB and start MS PowerPoint. ③ New menu with same icons as   MS-Word 2003
     will be appeared. Instruction and functions are
     the same. 

④  Instruction on slideshow mode is also the same as
      in MS-PowerPoint 2003. 

② Click Review on menu bar and select Start Ink tool on
     far right end.

2) Using DUO pen on MS-PowerPoint 2007 (4) Using DUO pen on MS-Outlook

1) Using DUO pen on MS-Outlook 2003

① Connect DUO to PC USB port and start MS-Outlook. 

② Click on New button in order to create an e-mail. 

③ Activate Ink annotation function. From menu bar, 
     Click on View> Tools> Start Ink annotation. 

④  Ink annotation icon will be activated as below.  
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⑤ Icon function includes different types of pen, eraser,
    colors and ink thickness. 

Choosing type of pen

Choosing eraser function

Choosing colors

Choosing ink thickness

Various colors are available as shown below.

⑦ Click on Send to e-mail your message.
 

⑧ You can create e-mail by using charactor recognizer.

 

⑥ When using ink annotation, HTML mode should be
     activated by default, and box will appeare as shown
     below. Size of box can be changed. Insert handwritten 
     message inside the box. 
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2) Using DUO pen on MS-Outlook 2007

① Connect DUO to PC USB port and start Outlook.

② Click on New to send an e-mail. 

③ Window will appeare as shown below.
    Click on start ink tool at far right end.  

④ Start writing message with your own handwriting
    using ink tool.

(5) MSN messenger
This is Microsoft software which allows ink chatting using text and pen.

③ When logged in successfully, main    
     window will be appeared as shown below. 

② Enter ID & password and login to messenger. If you
     don’t have ID, you have to register on MSN first.  
   

① Download and install the latest version of Windows live 
     messenger.  (http://get.live.com/messenger)

④ Start conversation by right-clicking on another  person’s
     ID. (Right click on  person’s ID)
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⑤ Below window will be appeared.

⑥ Start conversation.

⑧ Changing pen thickness and color is possible as well
     as eraser function. 

⑦ Now let’s try ink chatting. Click on ink chatting icon in
     order to carry out conversation using digital pen. Click
     on “Send” button to show your writing. 

⑨ Here are an examples using extra 
     options on MSN messenger.

61
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The software supports multipage and enables to write words, make memo and draw just like you write on piece of
paper with pencil. For XP and VISTA home basic, DUO InkNote provide same function as Windows Journal note. 

(6) Using Windows Journal Note ⑧ Extra functions 

Windows Journal note recognizes
pen pressure. Thus writings such
as brush can be done.

Select ‘Pen Settings..’ menu.

Before / after comparison

① Connect DUO to PC USB and start Windows Journal
     note. (Start > Program > Windows Journal note)

② Click Windows icon on lower left corner.

③ Click All programs.

④  Click Windows Journal note. 

⑤ Windows Journal note will be activated as follwing.

⑥ Basic functions of Windows Journal note.
Pen function

Eraser function

Highlighter function

⑦ Let’s make a simple memo using basic functions.
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(7) Using character recognizer (8) Using pen gesture (Flick)
You cae use character recognition function on your PC.
You can insert characters on any screen using character recognition board .

You can insert the result on any document software
using character recognition. After writing characters,
click on Insert. 

▶

Using character recognition board.
Move mouse pointer to tap of character recognition
board to utilize of recognition function.

1) Setting up
① Click on ‘Start’ button

② Move to ‘Control Panel’

③ Select ‘Pen and input devices’.

④ When window pops up, click on gesture. 
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You can insert long sentences by changing size of
character recognition board.

Windows Vista home premium or abover OS includes tablet PC function which provides pen flick. 
By moving your hand quickly on the screen with DUO pen, you can activate pen gesture fucntion. 
DUO must be connected to PC USB for activation of this function.

H e l l o ~

Default
settings
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(9) Using Capturing tool.⑤ Default icon for each direction will be shown. If you
     want to customize gesture, click on “Customize..”
     button. 

⑦ After setting up, quickly move DUO on screen to each
    direction in order to use gestures. 
    Practice is recommended for beginners. 

⑥ Customize according to your need and start using
     pen flick.

① Click on ‘Start’ button .

1) Setting up

② Click on ‘All Programs’.

③ Click on ‘Accessories’.

④  Click on ‘Snipping Tool’.

⑤ Screen will be changed to capturing mode. Select
     desired portion of screen using DUO pen.
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 You can use it with DUO pen for capturing of screen.
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(10) Using Sticky notes⑥ Capturing is finished when desired portion is selected. 

 Connect DUO to PC USB port and start Sticky notes. 
 You can write brief memo on sticky notes using pen. 

(11) Using Ink Desktop
Ink Desktop is software which utilizes desktop as writing
pad. It is not supported from OS by default. It is available
for free download from Microsoft website.

① Go to www.microsoft.co.kr

② Type “Ink Desktop” in website and click on search. 

③ Result page will be shown on the download link.
     Download and install Ink Desktop. 

⑦ You can save or e-mail captured portion. Please refer
     to Help from ‘Snipping tool’ for further instruction. 

① Click on ‘Start’ button. 

1) Setting up
1) Download

② Click ‘All programs’ 

③  Click ‘Sticky notes’.

④ How to use Sticky notes.

Sticky note will be shown as the above. You can write
simple memo using pen. 

If you want to write a new memo, click on new memo
button.

When you click on circled area, you can save voice
along with your memo.

DUO must be connected to PC for activation of
Ink desktop software..

Notice
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(12) Using PDF annotator
PDF annotator provides unrestricted annotations on PDF
file. It is not supported from OS by default. It is should be
purchased or download trial version from software website. 

① Click on ‘Start’ button .

2) Setting up

② Click on ‘All Programs’.

③ Execute by clicking on Ink Desktop menu.

④ How to use Ink Desktop

⑤ Toolbar 

By using Ink Desktop with DUO, you can write freely 
on desktop.

You can still select program icon on desktop when 
Ink Desktop is active.

Ink Desktop includes following functions.

ⓐ Choose types and colors of pen.
ⓑ Choose eraser function.
ⓒ Delete current page. 
ⓓ Set up various options. 
ⓔ Finish the program. 
ⓕ Show or hide icons.

① Go to http://www.grahl-software.com

② Download trial version from website or purchase 
     original version.

③ Application examples

④ Menu functions

PDF Annotator enables free annotation or writing on 
PDF files. You can emphasize by using highlighters or
attaching additional explanation on document. DUO
pen provides easier usage for annotating on PDF 
document.  

Pen/Highlighters/Eraser
Size of font

Choose color of pen
Stamp function

Zoom in and zoom out
Move along page
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(13) Transforming VISTA pen pointer to mouse pointer 

④ Select Pointer option

When pen device is connected to Windows VISTA home premium or above, cursor is changed very small point. 
Following explains how to change small cursor into conventional mouse cursor. 

10. Q&A

Can I use this product on third party software?

 Yes, you can use this product on all softwares if they support Mouse devices. 

 Can I connect it with usual mouse at the same time?

Sure. You can use two products in simultaneously.

Some optical mouse can makes trembling of mouse corsor.

We recommend to use mouse pad for optical mouse.

I want to use this on Painter(S/W) Does this have pressure level?

Presure level is not available now, but is under developing.

We provide virtual pressure function. Similar effect are available.

I didn’t use it for a long time and some liquid leaked from battery.

In case of not using for more than one month, you must disassemble the batteries from the pen.
The liquid from old battery may be harmful to the pen.
Please clean the leakage with dried cloth. If you have problem in your pen, contact your local distributors or seller.

 I’ve lost CD of PENonPC.

You can always download latest version of PENonPC from our homepage at http://www.penandfree.com

Q

Q

Q

Q

Q

③ Select ‘Pen and input devices’.
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⑤ Check the‘Show pen cursor ..’item and click on OK
    button.

① Click on ‘Start’ button. 

② Move to ‘Control Panel’
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Can the mouse cursor make big jitter?

 Computer does not recognize the product.

Product does not work properly.

Mouse pointer is jittering.

The products can be interfered with some metalic sounds or Infrared ray. (Projector Fan, Air conditioner, Vacuum
cleaner, Fluorescent lamp etc.) 

Please check installation of PENonPC again.
Please check PENonPC icon from system tray. If the icon is invisible, please install S/W again.
If you use any USB Hub, connect cable to PC directly.
Please check whether the USB cable is correct or not.
Separate USB and connect it againt

Please check the batteries in the pen.
Please check the direction of the battery(+/-).
Please check ultra sonic sound from the pen tip. If you can hear the ultra sonic  sound from the pen, it is O.K.
Even changed the batteries, the product does not work properly, please replace them all and re-insert the batteries.

If you can hear some metalic noises nearby, please remove the causes of noise.
Do you use it near CRT monitor? Please keep away form CRT monitor.
Please check the discharge of the batteries.
Please remove obstacles between Station and Pen.
When using with optical mouse, please use the mouse on mouse pad.
Do you use it near fluorescent lamp? Some fluorescent lamp can make jittering. 

If you find this error on your surroundings, please keep away form the cause of the trouble. 
Do not use with CRT Monitor.

Mouse cursor dose not move. What should I do? 

Please check the battery condition. Or remove and re-install the batteries in the pen.
Unplug the USB connector and quit PENonPC. And restart PENonPC and plug the USB connector.

Does the pen have battery saving mode?

If you don’t use the pen for 30 sec. the power of the pen is automatically off. 
If you want to use the pen again, please lightly touch the pen tip or press any button on the pen. 
The power will be automatically turned on.

Mouse cursor dose not align with pen. What should I do?

If you change the screen resolution or station position, you may need calibration of pen position.
Refer to ‘How to calibrate pen ’ section of this guide book.

Notice

If you need more information, visit www.penandfree.com.

11. Troubleshooting

Type 1

Type 2

Type 3

Q

Q

Q

Q



12. Product Specifications

13. Etc.

7776

Notice

Specification of the products can be changed without prior notice for better service and improvement.

13. Etc.

(1) Warranty 

1) In-warranty

 PenAndFree Co., Ltd. has repair/replcement policy about our product as below.

Warranty period : 1 year

12. Product Specification

Operating size: 170mm ~ 358mm diagonal ( 15.4 inch )

Power source : DC 5V (USB) / LR41 Cell battery (1.5V)

Technology : Ultrasonic and infrared

Sampling rate : Over 70Hz

Device standard : HID pen device

Resolution : About 600 LPI (Sampling) / Valid with 0.2mm

(1) Specifications

(2) System requirement

CPU

RAM

OS

Interface

Operating Temperature /Humidity

Storage Temperature /Humidity

USB port / CD-ROM driver

0~40 C / 20~ 80 % RH

-20~60 C / 20~ 90 % RH

Over 1 GHz 

Over 512 MB

Windows XP / VISTA (32 bit )

① Product defect/error in normal use within warranty period.

② Non proper service due to lack of material in material valid period.

Product defect/error in normal use within 1 week after purchasing
 >  Replacement or Refund (Refund is only possible from purchased shop.)

Product defect/error in normal use within 1 month after purchasing 

 >  Replacement

Product defect/error in normal use within warranty period after purchasing
 >  Free charge repair

Product defect/error in normal use within warranty period after purchasing
 > Replacement

User mistake in warranty period
 > Replacement with charge

Product defect/error after warranty period has ended.
> Replacement with charge

Over 3 times defect/error in same sympton even repairing 
> Replacement
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2) Out-Warranty
① Product disorder after warranty period

② Product damage/error by user mistake

③ Others

User mistake such as sink, impact and etc.

When damaged due to improper disassembling / assembling.

After repairing non-nominated repair center

Accessory or option device non-nominated by company.

Out of order or damage due to other careless behave.

Natural disaster such as fire, earthquake, flood and etc.

Over lifecycle of accessory like battery and others.

④ We are not resposible for damage or loss caused by through our product operating.

PENonPC S/W is the latest version at time of product manufaturing. We support version upgrading service
as customer service through Web for better quality. 
You can update S/W through our web on http://www.penandfree.com.

Our product S/W copyright is on PenAndFree Co., Ltd.

Check “Help” anytime on PENonPC menu for product operating guide.

Notice

Class B (Home IT appliance)Device class :

Note : This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures: 

   Reorient or relocate the receiving antenna. 
   Increase the separation between the equipment and receiver. 
   Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
   Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications not expressly approved by the party responsible for compliance could void the 
user's authority to operated the equipment under FCC rules.

 
Model No. : PMNA-01



13. Etc.

13. Etc.

8180

W
ar

ra
nt

y 
C

ar
d

N
am

e 
   

   
   

   
   

   
TE

L

Ad
dr

es
s 

   
   

   
   

   
 

D
is

tri
bu

to
r(A

ge
nt

): 
   

   
   

 T
EL

)  
   

   
  S

el
le

r  
   

   
  

D
at

e 
   

   
   

   
  W

ar
ra

nt
y 

Pe
rio

d 
fro

m
   

   
   

   
(1

 y
ea

r) 

Pu
rc

ha
se

r R
ep

ai
r S

ta
nd

ar
ds

Se
ria

l N
o.

 : 

R
ep

ai
r f

or
 o

ut
 o

f o
rd

er
/e

rro
r 

on
 u

su
al

 c
irc

um
st

an
ce

C
ar

el
es

s/
fa

ul
ts

 b
y 

us
er

D
es

cr
ip

tio
n

W
ar

ra
nt

y 
   

W
ith

in
   

   
   

   
   

   
   

   
   

O
ve

r 

R
ep

la
ce

   

C
ha

ng
ea

bl
e

   
 G

ra
de

   
   

   
   

   
   

   
   

  N
ot

e 
  

FC
C

 P
ar

t 1
5B

 C
la

ss
 B

C
on

ta
ct

 - 
W

eb
 : 

w
w

w.
pe

na
nd

fre
e.

co
m

 / 
e-

m
ai

l :
 s

al
es

@
pe

na
nd

fre
e.

co
m

C
ha

ng
ea

bl
e

re
pa

ir/
re

pl
ac

e

C
ha

ng
ea

bl
e

re
pa

ir/
re

pl
ac

e

Th
is

 d
ev

ic
e 

co
m

pl
ie

s 
w

ith
 p

ar
t 1

5 
of

 th
e 

FC
C

 R
ul

es
.

O
pe

ra
tio

n 
is

 s
ub

je
ct

 to
 th

e 
fo

llo
w

in
g 

tw
o 

co
nd

iti
on

s:
(1

)T
hi

s 
de

vi
ce

 m
ay

 n
ot

 c
au

se
 h

ar
m

fu
l i

nt
er

fe
re

nc
e,

 a
nd

(2
)T

hi
s 

de
vi

ce
 m

us
t a

cc
ep

t a
ny

 in
te

rfe
re

nc
e 

re
ce

iv
ed

,
In

cl
ud

in
g 

In
te

rfe
re

nc
e 

th
at

 m
ay

 c
au

se
 u

nd
es

ire
d 

op
er

at
io

n


	1 (cover)
	2-3
	4-5
	6-7
	8-9
	10-11
	12-13
	14-15
	16-17
	18-19
	20-21
	22-23
	24-25
	26-27
	28-29
	30-31(XP_잉크채팅)
	32-33
	34-35
	36-37
	38-39
	40-41
	42-43
	44-45(Vista Premium)
	46-47
	48-49
	50-51
	52-53
	54-55
	56-57
	58-59
	60-61
	62-63
	64-65
	66-67
	68-69(캡쳐도구)
	70-71
	72-73
	74-75
	76-77
	78-79
	80-81

